
LCD Back Lighting Tutorial

This is a tutorial for users of TracePro Expert.



LCD Back Lighting Tutorial
LCD Back Lighting Tutorial

This tutorial illustrates how to use TracePro for the analysis of LCD Back Lights. The steps include 

• generating a solid model

• applying material properties

• applying surface properties

• creating and applying RepTile properties

• creating surface sources

• tracing rays

• viewing irradiance 

The tutorial also provides an expanded description of the irradiance options included in TracePro.
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LCD Back Lighting Tutorial
Create an LCD Panel 

The first step will be to create the LCD Panel

1. Start TracePro.

2. From the Insert Menu, select Primitive Solid.

3. Select the Block Tab and enter the Width values 100 for X, 10 for Y and 100 for Z.

4. Click the Insert button to create the block.

5. Press the Zoom All button or select the View|Zoom|All menu to see the new object
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LCD Back Lighting Tutorial
Opening the System Tree

The TracePro System Tree provides an expandible list of data showing model object and surfaces along with their properties. 

1. To open the System Tree go to the Window Menu and select the Split option. This option moves the mouse cursor over the splitter bar
at the left of the window. You can do the same by moving the mouse there yourself.

2.  Drag the splitter bar to separate the window into two separate and distinct areas, one showing the System Tree and the second the 3D
viewing area.

3.  Left mouse clicking on any + sign in the System Tree opens the object or surface to display more information. 
TracePro Release 3.2 4



LCD Back Lighting Tutorial
Adding Material Properties to the LCD Panel

TracePro attaches properties to the model objects and surfaces in
order to create an “optical model”. The LCD Panel needs to be made
optical by the application of a Material Proeprty.

1. Click on the block in the System Tree to highlight it in the tree and
the viewing area.

2. Right-click either on the viewing side or the tree side of the screen
to open a pop-up menu. Select Properties to open the Apply
Properties dialog box. (You can also do this by selecting
Define|Apply Properties from the TracePro menu.)

3.  On the Apply Properties dialog box, select the Material Tab.

4.  Select the Plastic Catalog and the Polycarb name using the drop-
down lists.

5.  Click the Apply button to apply the property. 

6. The System Tree should show the Plastic Polycarb as the material
applied to the block.

Popup in System Tree

Popup in Model View
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LCD Back Lighting Tutorial
Adding Surface Properties to the LCD Panel

Add a mirrored surface to the bottom and three sides of the panel you
need to select surfaces 1, 2, 3 and 5. 

1. First expand the block object by clicking on the + sign next to the
object.

2. Click on Surface 1 to highlight the surface in the System Tree and
the viewing area. 

3. Hold the Ctrl key down and click on surfaces 2, 3, and 5 to add
them to the selection.

4.  In the Apply Properties dialog box, select the Surface tab. 

5. Using the drop-down list, select the Perfect Mirror property. 

6. Click the Apply button to apply this property to all the selected
surfaces. 

7.  Look in the System Tree to verify that the surface property has
been applied to the correct surfaces

.
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LCD Back Lighting Tutorial
Creating the Fluorescent Tube

The panel will be illuminated from the side by a fluorescent tube. The next
several steps will create the tube.

1. To create the fluorescent tube, from the Insert Menu select Primitive
Solid, then select the Cylinder/Cone tab.

2.  Enter the radius, length, base position, and rotation as shown in the
dialog box at right.

3.  Click the Insert button to create the cylinder.
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LCD Back Lighting Tutorial
Adding a Surface Property to the Bulb

1. Click on the + sign of the object that was just created to expand
the tree and display the three surfaces that make the cylinder: the
two plane ends and the cone between the ends.

2.  Click on Surface 0 to highlight the surface in the System Tree and
the viewing screen.

3.  Click on the + sign of Surface 0.Right-click on the viewing area to
open the pop-up menu.

4.  Select Properties.

5.  Select the Surface tab.

6.  Using the drop-down list, select the Fluor White property.

7.  Click the Apply button at the bottom of the Apply Properties
dialog box to apply the property.

8.  Surface 0 should now display the Surface Property Fluor White as
shown in the figure.
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LCD Back Lighting Tutorial
Adding a Surface Source Property to the Bulb

The next step with the tube is to add a Source Property to the tube’s
cylindrical surface. Surface Sources define emitting surfaces in
Tracepro.

1. On the Apply Properties dialog box, select the Surface
Source tab.

2. For the Source Type select Flux, enter Flux of 30 Watts, set the
Number of Rays to 1000, and set the Angular Distribution to
Lambertian.

3. Click Apply to apply this source property to surface 0.
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LCD Back Lighting Tutorial
Creating the Reflector around the Source

A reflecting surface will be added to collect the light from the source which is
emitted away from the panel and redirect the light into the panel.

1. Select Insert|Primitive Solid to open the Insert Primitive Solids
dialog box.

2. Select the Cylinder/Cone tab and insert a cylinder with the dimensions
as shown in the dialog box at right.

3. Make a second cylinder slightly shorter and smaller in radius than the
first. This will define the inside of a cylindrical shell.

4. After inserting a cylinder with the dimensions as in the dialog box below,
you will have two cylinders that are positioned around the bulb.

Outside Reflector Dimensions

Inside Reflector Dimensions
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LCD Back Lighting Tutorial
Creating the Reflector

The reflector shell will be made by subtracting the inner cylinder from the outer cylinder using a Boolean Subtraction operation.

1. Select the outer (larger) cylinder in the System Tree.

2. Select the inner (smaller) cylinder in the System tree while pressing the Ctrl key. This is call a Ctrl+Click and extends the selection tow
include both objects.

3. Select the Boolean Subtract icon, or use the Edit|Boolean|Subtract menu to perform the Boolean operation.

4. then click on the Object number that is the larger cylinder in the System Tree, then click on the smaller cylinder in the tree. The result
will be one object with 6 surfaces.

5.  If you make a mistake, click on the Undo Icon or select Edit|Undo to reverse the subtraction operation and try again.
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LCD Back Lighting Tutorial
Creating the Reflector

You only need the right half of the reflector shell. Another Boolean Subtract
is used to complete the creation of the reflector geometry. Start by inserting
a second block and use it to cut off half the reflector.

1. Open the Insert Primitive Solids dialog box and make a block with the
dimensions shown at right.

2. Select the reflector shell

3. Ctrl+Click select the block.

4. Click the Boolean Subtract icon.

5. This should create the half-cylinder reflector that you need.
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LCD Back Lighting Tutorial
Applying a Surface Property to the Reflector

1. Using the System Tree, click on the reflector object, expand it and click on the surface tagged “Cone 4.9 millimeters” This is the inside
cylindrical surface of the reflector.

2. In the Apply Properties dialog box, Surface tab, select the Diffuse White surface property. 

3. Click Apply to apply it to the reflector surface.

4. An expanded view of the object is shown in the System Tree.
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LCD Back Lighting Tutorial
Creating a dot pattern using RepTile™

Now you will create a dot pattern using the RepTile™ feature in TracePro Expert Edition.

1.  Select Define|Edit Property Data|RepTile Properties to open the RepTile Property Editor
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LCD Back Lighting Tutorial
Creating a dot pattern using RepTile

You can add and edit property data with the Tracepro Property editors. The next step is to add a RepTile property for the LCD panel.

1. In the RepTile Property Editor, click Add Reptile Property.

2. Type in LCD panel dot pattern for the name, and select Geometry Type = Sphere. 

3. Click OK to create the property.
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LCD Back Lighting Tutorial
Creating a dot pattern using RepTile

1. Select Tile Parameters Rectangles from the drop-down list.

2. Enter 5 for both the Width and Height.

3. In the spreadsheet part of the editor, enter 1 for the radius and 1 for the height.

4. Finally, click the Bump button to change it from Bump to Hole.

5. The completed property should appear as shown.

6. Click the Save icon to save the property in the database (or select File|Save) and close the Editor.
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LCD Back Lighting Tutorial
Creating a dot pattern using RepTile

The RepTile property will be used on the bottom of the LCD panel to
improve the uniformity of the reflected light.

1. Select the bottom surface of the LCD in preparation for applying
the RepTile property. It’s also a good idea to label the objects and
surfaces for easy reference. Surface and object names are
modified by clicking in the Stem Tree label and typing the new
name. 

2. Open the Define|Apply Properties dialog box and select the
RepTile tab.

3. Select the LCD panel dot pattern property and Diffuse White
surface property

4. Enter the values shown for boundary dimensions, center, (0,0) tile,
and Up Vector.

5. Press Apply to update the surface.

The patterned surface is now complete. 

• You have created a 98x98 mm rectangular region on the bottom
surface filled with spherical holes (as seen from the outside of
the solid).

• The surface property on the substrate is Perfect Mirror, and the
property on the holes is Diffuse White.

• The holes are spaced 5 mm apart and are 1 mm in radius.
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LCD Back Lighting Tutorial
Display the RepTile Surface

RepTile surfaces do not have geometry like other objects and surfaces in TracePro but can be displayed.

1. Select the View|Display RepTile menu.

2. Select the View|Profile|Iso 1 menu.
TracePro Release 3.2 18



LCD Back Lighting Tutorial
Adding an observation screen

An observation screen defines the output of the LCD panel and can be located anywhere in space. The object will allow you to examine the
irradiance distribution from your light guide.

1. To add an observation screen to the system, select Insert|Primitive Solid and select the Block tab.

2. Enter the width and position for the block as shown.

3. Label the object Observation Screen.

4. Apply the Perfect Absorber surface property to the object. This operation will apply the surface property to all member surfaces of the
object.

5. Label the bottom surface Screen.
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LCD Back Lighting Tutorial
Turning the Display of Rays off

Since you are tracing 1,000 rays and having them scatter into 1000s of more rays it is a good idea to turn off the display of rays off before
the ray-trace, so the screen doesn’t become too cluttered with rays. 

1.  To do this go to the Analysis menu and left mouse click on the Display Rays option.

2.  The check mark in front of the Display Rays option should disappear.
TracePro Release 3.2 20



LCD Back Lighting Tutorial
Running a source trace simulation

1. Now click on the Source Trace icon to begin the Surface Source ray-trace. 

2. Before the ray-trace begins, TracePro will Audit the system. All properties will be preprocessed, and the object space will be partitioned
for faster ray-tracing.

3. When the ray-trace begins, a dialog box will appear showing how long the ray trace will take and what ray is currently being traced. The
time it takes will depend on your computer, but expect it to take a few minutes.

4. After the audit is finished, TracePro will start ray tracing 1,000 rays. 
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LCD Back Lighting Tutorial
Display Ray Trace 

With large numbers of rays the ray display sheds little light on what is happening in the model. The Ray Sorting options in Tracepro provide
a way to reduce number and select the type of rays to display.

1. Select Analysis|Ray Sorting. 

2. Change 100 to 5 in the % Starting Rays to Display and click Update. This will reduce the number of rays shown to 5 out of every 100.

3. Turn the Display Rays option back on by selecting Analysis|Display Rays. Rays will be displayed.

The observation screen was set to be completely absorbing and most rays reach, and stop at, its bottom surface. Rays missing this object
are shown bypassing it. The color of each ray indicates its flux. Red rays have flux from 100 to 66 percent of their beginning ray flux. Green
rays are between 66 and 33 percent and blue rays are between 33 and 0 percent. 
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LCD Back Lighting Tutorial
Displaying an Irradiance Map

There are two modes to trace rays in TracePro,
Analysis and Simulation mode. Analysis mode lets the
user look at Irradiance/Illuminance maps and Candela/
Intensity plots on any surface. Simulation mode lets the
user look at only one surface that must be defined
before a ray trace takes place. Simulation mode has
less flexibility, but uses much less memory.

By default Analysis mode is on. 

1. Select Analysis|Irradiance Options. 

2. Update the Irradiance Options as shown to
correctly display an Irradiance Map. 

3. Click Apply to make the new settings take effect.
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LCD Back Lighting Tutorial
Irradiance map

When showing an Irradiance map, a surface needs to be selected to define the map’s data set.

1. Select the Screen surface of Observation Screen object.

2. Click on the Irradiance Map icon (or select Analysis|Irradiance/ Illuminance Map) to see the plot shown at right.

3. Click in the center of the irradiance map to get the profiles to appear. The two profiles will pass through whatever point you click.

4. The irradiance map shown should pop-up on the screen. 

5. To see the windows side by side as shown, select Window|Tile Vertical or click the Tile Vertical toolbar button.
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LCD Back Lighting Tutorial
Improve Irradiance Sampling

The Irradiance plot displayed with 1000 rays is greatly under sampled. This can be improved by increasing the rays traced and displaying
the plot.

1. Start by turning off the ray display from the Analysis menu and left mouse click on the Display Rays option.

2. Select the source surface and update the number of rays from 1,000 to 10,000. See “Adding a Surface Source Property to the Bulb”.

3. Perform a source raytrace and view the Irradiance Map.
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LCD Back Lighting Tutorial
Understanding the Irradiance Options

The Irradiance/Illuminance Options dialog box is shown
at right. This dialog box is available from the Analysis
Menu and is used to set all the parameters for the
Irradiance/Illuminance Map.

The default Rays to Plot setting is Absorbed rays. If you
do not see any irradiance/illuminance on a surface,
change this option to incident and an Irradiance/
Illuminance Map should appear. This system is set to
Radiometric units so that all output units are shown in
Watts and Watts per meter squared. 

To change radiometric units to Photometric, select
Analysis|Raytrace Options and change the
Radiometric Units setting.

If the Normalize to emitted flux box is checked the flux
of each ray is divided by the total emitted flux from the
source(s) before being added to the irradiance map. Us
this to calculate the efficiency of a light pipe when you
have many sources. 

The foreground and background colors of the map are
set using the Color Map option. Black&White and
grayscale maps are good for sending maps over faxes
or Black and White printers. Color is best for pseudo-
color display. 

The Count option determines the number of pixels used
by the map to collect rays. A count set to 20 divides the
detector into a 20x20 grid of pixels and counts the rays
striking each section of the grid and then totals the
energy of these rays together. Larger counts show
more rays and provide a more accurate view of what is
happening on the map if small detail is needed. Smaller
counts let you trace fewer rays and get a quick,
approximate idea of what the system looks like.

The Smoothing option applies a Gaussian smoothing across the detector pixels to smooth out choppy or non-contiguous data. Use this to
trace fewer rays while debugging your system or while in early design stages and let the Gaussian smoothing function fill in the missing
data.
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LCD Back Lighting Tutorial
Understanding the Irradiance Options

The Profiles option creates the cross sectional plots of
the map. Clicking anywhere on the map will show a
cross section in both profiles of a horizontal and vertical
cut through the map. The profiles intersect at the point
you click.

The Normal and Up Vector selection sets the projection
plane that all rays will be collected on. If you have a
doubt what the collection plane is, the program can
automatically calculate the Normal and Up vector for
you. Just click on the Automatically calculate Normal
and Up Vector box. Remember you must click Apply
before any option is applied to the map. 

• The normal vector is the vector that is
perpendicular to the collection plane.

• The Up vector is parallel to the vertical side of the
plane.

If the Normal and Up vector box is entered with the
wrong vectors the map may look incorrect. This
incorrect map may look like a slice if the selected plane
is perpendicular to the correct plane or may show no
results at all.
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